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LOGIN TO AXXESS 
Navigate to www.axxess.com. Select the LOGIN button. 
 

 
 
Input user credentials and select the Secure Login button. 
 

 
 

AXXESS PLANNER 
The Axxess Planner displays pertinent information specific to a user. Shortcuts 
have been placed on the left side of the page to allow for easy access to the 
Axxess applications the organization is using. Clinicians can also see upcoming 
visits, past due visits, unread messages, and a map of today’s visits. To access 
client charts, document a visit or bill for a particular client, select the appropriate 
Axxess application on the left side of the page.  
 

 

http://www.axxess.com/
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NAVIGATION MENU 
Once logged in, the navigation menu at the top will allow for easy access to the 
data.  
 

 
 

Home 
The Home menu allows access to the following actions based on permissions 
granted to the user. 

 
 

Alert Center - Various administrative alerts are generated in this screen for an 

organization to act on. 
 

 
 

My Account - Users can quickly edit their profile or reset their signature. 
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Quality Assurance (QA) Center - View tasks that are pending approval by 

the QA Nurse. 
 

 
 

My Schedule - View the schedule/tasks in a list view. 

 

 
 

My Dashboard - Opens the Home Care dashboard. 
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My Messages - Opens the Message Center to view/send messages. 

 

 
 

Create 
The Create menu allows access to the following actions based on permissions 
granted to the user. 

 
 

Client - Allows a user to create either a Medical or Non-Medical Client. 
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Referral - Create either a Medical or Non-Medical Referral. 

 

 
 

Inquiry - Opens a new window that allows a user to create a new inquiry for a 

potential client. 
 

 
 
Care Period - Opens a new window that allows a user to create a care period 

for a client. 
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Message - Opens a blank message to compose to another user in the system. 

 

 
 

 
 
Communication Note - Creates a new communication note for a specific 

client/care period.  
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Personnel Note - The personnel note is permission-based and enables 

organizations to document employee communication 
 

 
 

Authorization - Creates a new authorization detail for a specific client.  
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Order - Creates a new order for a specific client. 

 

 
 

Facility - Creates a new facility within the Home Care system for selection.  
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Payment Source - Creates a new payment source within the Home Care 

system. 
 

 
 

Physician - Creates a new physician within the Home Care system.  
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Contact - Creates a new contact within the Home Care system.  

 

 
 

Incident/Accident Log - Creates a new incident/accident log specific to a 

client.  
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Infection Log - Creates an infection log record for a specific client. 

 

 
 
Physician Face to Face Encounter - Creates the face-to-face encounter 

documentation for a specific client/care period.  
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Pharmacy - Creates a new pharmacy within the Home Care system.  

 

 
 

Treatment - Creates a new treatment within the Home Care system.  

 

 
 

View 
The View menu allows access to the following actions based on permissions 
granted to the user. 
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Orders Management - View orders that are pending co-signature, pending 

physician signature, orders to be sent and orders history. 
 

 
 

OASIS Management - Location to review OASIS ready for export, OASIS 

previously exported and OASIS that have not been exported.  
 

 
 
Lists - View items in the system, such as a list of Referrals, Clients, Physicians, 

Payment Sources, etc. 
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Print Queue - Displays tasks that are ready to be printed and delivered to the 

appropriate recipient. 
 

 
 

Blank Forms - View blank versions of visits to be printed and filled out 

manually. 
 

 
 

Clients 
The Clients menu allows access to the following actions based on permissions 
granted to the user.  
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Client Center - View client charts within the system, including Active, Pending, 

Discharged, Non-Admitted and Hospitalized clients. 
 

 
 

Referrals - View a list of pending referrals and begin the admission process. 
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Inquiries - View a list of inquiries to be edited, converted into referrals or 

removed. 
 

 
 

Pending Admissions - View and add new clients for admission into the 

system. 
 

 
 

Non-Admissions - Inclusive list of all non-admissions logged in the system. 

From this screen, a user can also admit a client if they were marked incorrectly. 
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Hospitalization Logs - Clients that have been transferred to the hospital by 

completing a Transfer OASIS are visible in this screen for tracking purposes. 
 

 
 

Deleted Clients - Clients that have been deleted from the system are visible in 

this screen and are able to be restored, if necessary. 
 

 
 

Schedule 
The Schedule menu enables access to the following actions based on 
permissions granted to the user. NOTE: See Intake/Scheduling manual for 
further details. 
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Schedule Center - Client-specific schedule is accessible from this screen 

which also enables a user to add additional visits to the schedule. 
 

 
 

My Schedule - View the user’s schedule/tasks in a calendar or list view just like 

under the Home tab. 
 

Unassigned Shifts - Central location to identify upcoming shifts that have not 

been assigned to a worker. 
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Organization Schedule - Overview of all visits occurring throughout the 

organization for a given date.  
 

 
 

Copy Week - Enables users to copy a scheduled week of visits for a client.  

 

 
 

Pending Co-Signature - Notes that require a Co-Signature will be listed in this 

section until signed by the responsible co-signer. 
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Billing 
The Billing menu allows access to the following actions based on permissions 
granted to the user. NOTE: See Billing manual for further details. 
 

 
 

Invoice - Enables a user to create invoices, review outstanding invoices and 

invoice history for clients on private pay.  
 

 
 

Managed Care/Other Insurances - This menu provides a user access to 

create claims for managed care/other insurances as well as review outstanding 
claims, claims history and claim submission history. 
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Pending Claims/Collections - This menu enables users to manage all claims 

and invoices with outstanding balances in a central location. 
 

 
 

 
Remittance Advice - This menu enables users to view remittance advice and 

add checks. 
 

 
 

Employees 
The Employees menu enables access to the following actions based on 
permissions granted to the user. 
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Employee Center - Employee records and access permissions are managed 

from this screen. 
 

 
 

New User – A direct link to be able to add a new user. 
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Payroll - Reports for payroll purposes can be run from this screen. 

 

 
 

License Manager - Administration of employee licenses are handled from this 

screen, enabling quick identification of an expiring license.  
 

 
 

Admin 
The Admin menu enables access to the following actions based on permissions 
granted to the user. NOTE: See Admin manual for further details. 
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New - Add new items in the system, such as a Referral, Facility, Pharmacy, etc. 

 

 
 

Lists - View items in the system, such as a list of Referrals, Clients, Physicians, 

Payment Sources, etc. 
 

 
 

Company Setup - Company-wide settings and information are managed from 

this screen.  
 
NOTE: An Administrator/DON (permission-based) signature is required to access 
this screen.  
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Reports 
The Reports menu enables access to the following actions based on 
permissions granted to the user. 

 
 

Report Center - Provides access to reports available within the system. 
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Completed Reports - Some reports will be queued until compiled. Once the 

data has been compiled, the report will be available from this section.  
 

 
 

EVV Exception Center - Enables users to manage, correct and resubmit EVV 

data when EVV exceptions occur. 
 

 
 

Help 
The Help menu enables access to the following actions based on permissions 
granted to the user. 
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User Community - Direct link to the user community for users to connect, 

share, learn and grow together. 
 

 
 

Help Center – A direct link to the Help Center that has answers, articles and 

videos related to Home Care content. 
 

 
 

On-Demand Training - A direct link to a host of different Axxess Home Care 

Live Webinars.  
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Recent Software Updates - Identifies recent updates made to the software, 

including bug fixes and new features.  
 

 
 

Submit a Ticket - Direct link to submit a support ticket for a current issue. 

 

COVID-19 Resource Center - A direct link to the Axxess COVID-19 

Resource Center which includes Best Practices, Hear from Experts, Helpful 
Downloads, Personal Protective Equipment (PPE) and Helpful Links. The page 
can also be found by going to www.axxess.com/covid-19 
 

Follow Axxess - Connect with Axxess on social media including Facebook and 

LinkedIn using the quick links provided in this menu. 
 

RESET SIGNATURE 
Home/My Account/Reset Signature.  
 
A new window will display, as seen below. Select Reset Signature and a link will 
be sent to the email address associated with the account. Review the system 
generated email that was sent to the user’s email address for a personalized link 
to reset the signature. Upon selecting the link, a screen will appear in the web 
browser prompting to verify the information and enter a new signature. 
 

http://www.axxess.com/covid-19
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After inputting a new signature, select Change signature and a prompt will 
display confirming the change was successful. Close the internet browser 
window and log back into Axxess to use the newly updated signature. 
 

RESET LOGIN PASSWORD 
To reset the Axxess login password, follow one of the methods listed below. 
 

Current Login Password is Unknown 
Navigate to the login page and select Forgot your Password? Continue to 
follow the prompts to enter the email address used to login to Axxess and select 
Send. This will send a password reset link to the user’s email address.  
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Current Login Password is Known 
Home/My Account/Edit Profile.  
 
On this screen, input the current password and new password desired in the 
boxes provided. Select Save to confirm the change. 
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HELP CENTER 
Help/Help Center  
A great resource that is available 24/7 is our Help Center. It is a place to get 
answers to frequently asked questions or watch videos of all of Axxess’ products. 
It can be accessed by going to:  
 

 
 

Or also available at https://www.axxess.com/help/ 
 

 
 

https://www.axxess.com/help/

